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Introduction
The Fade application allows you to create, edit and display a simple slideshow.

Main features are:

• Various different picture to picture fades are available
• Uses ChangeFSI & ImageFileRender so a wide range of image formats are supported
• Slideshows run in any 8,16 or 32 bit screen mode

Requirements
Fade should run on any RISC OS 3+ machine with 2Mb of memory. It does require the Toolbox modules so this might push
requirements up somewhat. Any processor should do although some transitions work a lot better with a faster processor.

Please note that this release of Fade has only been tested on RISC OS 4 and RISC OS 6.
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Getting started

Loading Fade
Fade is loaded by double clicking on the Fade icon in the filer display: 

Once loaded an the Fade icon will appear on the iconbar in the standard way.
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Creating a new slideshow
Clicking Select on the icon bar icon will cause a window to appear. Dragging images to this window will cause thumbnails of the
images to be displayed (unless this has been turned off - see Choices).

Toolbar for common operations

Thumbnails of pictures

Transition effect for next image
Transition effect for previous image

Pictures are linked by an upward and downward arrow (when using a vertical view - a horizontal view is also available). Double
clicking on these arrows will display a window which allows the next and previous transition types and times to be set.

Double clicking on the image itself will display limited information about the underlying file.
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Setting the fade type
The Fade details window is displayed by double clicking on the upward or downward pointing arrows. These represent the
transitions to the previous and next pictures in the sequence respectively. The two icons linked by the arrow show the from and
to pictures for the transition and the arrow shows the direction of the fade.

Fade type
The Fade type field allows the user to pick the transition type to use from the list. Available types are:

Random
Picks a random fade from the list below.
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Slide down (cover)
Slides a new picture down over the existing picture.

Slide up (cover)
Slide a new picture up over the existing picture.

Slide right (cover)
Slides a new picture right over the existing picture.

Slide left (cover)
Slides a new picture left over the existing picture.

Slide down (uncover)
Slides the existing picture down to reveal a new picture.
    

Slide up (uncover)
Slides the existing picture up to reveal a new picture.

Slide right (uncover)
Slides the existing picture right to reveal a new picture.
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Slide left (uncover)
Slides the existing picture left to reveal a new picture.

Scroll down
Scrolls the existing picture down and the new picture into view.

Scroll up
Scrolls the existing picture up and the new picture into view.

Slide right
Scrolls the existing picture right and the new picture into view.

Slide left
Scrolls the existing picture left and the new picture into view.

Random horizontal bar
This will draw a horizontal line at random from the new picture until the whole
picture is displayed.

Random vertical bar
This will draw a vertical line at random from the new picture until the whole
picture is displayed.
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Shutter down
Draws a series of evenly spaced horizontal lines until the whole picture is
visible. This effect is similar to pulling the cord on a shutter blind and having the
blind close upwards.
    
Shutter up
Draws a series of evenly spaced horizontal lines until the whole picture is
visible. This effect is similar to pulling the cord on a shutter blind and having the
blind close downwards.
    
Shutter right
Draws a series of evenly spaced vertical lines until the whole picture is visible.
This effect is similar to pulling the cord on a shutter blind and having the blind
close towards the right.

Shutter left
Draws a series of evenly spaced vertical lines until the whole picture is visible.
This effect is similar to pulling the cord on a shutter blind and having the blind
close towards the left.

Wipe down
Displays the picture moving from the top of the screen down.

Wipe up
Displays the picture moving from the bottom of the screen up.
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Wipe right
Displays the picture moving from the left of the screen right.

Wipe left
Displays the picture moving from the right of the screen left.

Unroll
This is much like unrolling a piece of paper with the new picture on it.

Switch
Simply displays the new picture as quickly as possible.

Check down
Displays the new picture using a chequer board effect with each square
appearing from left to right.

Check across
Displays the new picture using a chequer board effect with each square
appearing from top to bottom.
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Box out
Draws a box starting in the centre of the screen getting bigger until the whole
picture is displayed.

Box in
Draws a box starting at the outer edges of the screen getting smaller until the
whole picture is displayed.

Vertical split out
Starts from the centre of the screen drawing vertical bars moving outward until
the whole picture is displayed.

Vertical split in
Starts from the edge of the screen drawing vertical bars moving inwards until
the whole picture is displayed.

Horizontal split out
Starts from the centre of the screen drawing horizontal bars moving outward
until the whole picture is displayed.

Vertical split in
Starts from the edge of the screen drawing horizontal bars moving inwards until
the whole picture is displayed.
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Diagonal left down
Horizontal bars are drawn from the top right of the screen until the whole picture
is displayed.

Diagonal left up
Horizontal bars are drawn from the bottom right of the screen until the whole
picture is displayed.

Diagonal right down
Horizontal bars are drawn from the top left of the screen until the whole picture
is displayed.

Diagonal right up
Horizontal bars are drawn from the bottom left of the screen until the whole
picture is displayed.

Dissolve
Random squares are draw until the whole of the picture is displayed.
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Speed
This controls how quickly the transition will happen by changing the amount of the transition that happens in one go. For
transitions that scroll or slide a faster speed will make the transition occur in bigger steps which might make the transition less
smooth. However, this is sometimes necessary on slower machines.

Using a slow speed here but a faster speed in the Choices window (see later) will provide a smoother transition.

Delay
The Delay box controls whether the transition from one picture to another will happen after a given time or when a mouse button is
clicked. If a time is specified then clicking the mouse buttons during the slideshow will override it.

Click the Set type button to store the fade details.

Setting the fade type via the toolbar
The Fade details window can also be displayed by clicking the Next or Previous fade buttons on the toolbar:

Display the fade details used to move to the next picture

Display the fade details used to move to the previous picture
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Picture information
Limited information can be displayed about a picture by double clicking on it.

The type and size of the picture are shown along with the following settings that can be changed.

Preserve aspect ratio
This ensures that when the picture is rescaled to fit the screen the aspect ratio will be maintained.

Background
Switching this on allows the background colour of the picture to be specified. This is particularly useful with Draw files or pictures
where the above setting will cause a margin to displayed. Click the colour popup to display a standard colour selector .

Click on the OK button to save the setting.

The Open button will load the picture into the appropriate editor for changes to be made.
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Displaying picture information from the toolbar
The Picture information window can also be displayed by clicking the picture information button on the toolbar:

Displays the details for the selected picture
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Operating on multiple pictures
Sometimes it can be useful to change the fade details for several pictures at once. This can be achieved by highlighting more
than one picture at once in the fade window and selecting the appropriate item in the Edit menu:

The following options are available.

Picture details
This will display the Picture information window for each highlighted picture.
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Fade to next picture
This will display the Fade details window for each highlighted picture to allow the transition used to display the next picture in
the sequence to be set.

Fade to previous picture
This will display the Fade details window for each highlighted picture to allow the transition used to display the previous picture
in the sequence to be set.

Multiple fade to next picture
This will display a single window which allows the transition used to display the next picture in the sequence to be set for all of
the highlighted pictures at the same time.

Multiple fade to previous picture
This will display a single window which allows the transition used to display the previous picture in the sequence to be set for
all of the highlighted pictures at the same time.
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Multiple fade details
This window allows the fade details to be set for all of the currently highlighted pictures:

Fade type
The Fade type field allows the user to pick the transition type to use from the list. See the section Setting the fade type for a
description of the different transitions available.

Speed
This controls how quickly the transition will happen by changing the amount of the transition that happens in one go. For
transitions that scroll or slide a faster speed will make the transition occur in bigger steps which might make the transition less
smooth. However, this is sometimes necessary on slower machines.

Using a slow speed here but a faster speed in the Choices window (see later) will provide a smoother transition.

Delay
The Delay box controls whether the transition from one picture to another will happen after a given time or when a mouse button is
clicked. If a time is specified then clicking the mouse buttons during the slideshow will override it.

Click the Set type button to store the fade details.
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Running the slideshow
Choose Run slideshow from the Slideshow item on the main menu.

Fade will take over the whole screen and display the first picture. If a time delay was specified then the next picture will be
automatically displayed using the fade type chosen after the specified delay. Alternatively clicking Adjust will move to the next
picture and Select will move back to the previous picture.

Clicking the Menu button will cause a slideshow pause. Clicking Menu again will terminate the slideshow whilst clicking Adjust
will resume the slideshow.

Page 17



Running the slideshow from the toolbar
The slideshow can also be run by clicking the run button on the toolbar.

Runs the slideshow from the beginning

Highlighting areas
When a slideshow has been paused areas of the screen can be highlighted by dragging with Select. Clicking Adjust will remove
the highlights.

An example of a slide with a highlighted area is shown below:

Saving highlighted areas
Sometimes it is useful to be able to save a picture when areas of it has been highlighted. Pressing the S key after areas of a
picture have been highlighted will cause a copy of the picture to be saved. This will be given a name based on the time and date
when it was saved. The location of the saved picture is configurable via Choices which is covered later.
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Saving a slideshow
Saving a slideshow is done in the normal RISC OS style by selecting the Save item from the File menu and dragging the icon
to a filer display:

Fade can copy pictures and store them within the save directory. This behaviour is configurable through the Choices dialog.
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Exporting a slideshow as HTML
A slideshow can be exported as HTML and viewed in a web browser. Choose Save HTML from the File menu to save a directory
containing the slideshow:

There are a number of different ways the slideshow can be exported as HTML and most of the different settings are configurable
from the Choices window which is covered later.

The save dialog does however offer a couple of alternatives.

Slideshow title
The title of the slideshow can be set by editing this in the save dialog. The special token $Filename$ will include the full path

name of the slideshow.
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Saving an overview
Switching on Save an overview of the slideshow will save a simple overview of the images and fades that make up a slideshow.

Double clicking on the generated index/html file within the directory thats is created will load the preview into a web browser if
you have one installed:

The preview can then be printed from within the web browser if desired.
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Saving the whole slideshow
If Save an overview of the slideshow is not switched on then all of the images that comprise the slideshow will be saved along
with an index. The slideshow can be configured to use frames, auto progress from one image to another or have Next and
Previous buttons.

Double clicking on the generated index/html file within the directory thats is created will load the slideshow into a web browser
if you have one installed. Some example configurations are shown below:
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Loading a slideshow
To load a Fade slideshow double click on it or drag it to the icon bar icon.

Dragging to an open window will merge it with an existing slideshow.

Note that Fade files are stored as applications. Fade will do some checks when a file is loaded but trying to load a non Fade
application may have unpredictable results.
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Drag and drop
Fade supports drag and drop within the main window to allow easy reordering of pictures within the slideshow:

The following drag operations are available:

• Dragging with Select within a slideshow will move the selected objects to the new position.

• Dragging with Select with shift held down within a slideshow will copy the selected objects to the new position.

• Dragging with Select to another slideshow will copy the selected objects to the new position in the target slideshow.

• Dragging with Select with shift held down to another slideshow will move the selected objects to the new position in the
target slideshow.
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Cut & paste
It is possible to highlight thumbnails by using Select and Adjust in the standard way. The operations on the Edit menu are then
available:

Cut
Remove the selected images from the fade and store them on an internal clipboard. The cut button on the toolbar can also be
used to cut the current selection:

Cuts the selection the clipboard

Copy
Copy the selected images to the internal clipboard. The copy button on the toolbar can also be used to copy the current selection:

Copies the selection to the clipboard

Paste
Paste the contents of the internal clipboard. The mouse pointer will change shape and the user must then click where they wish
the clipboard to be pasted. The paste button on the toolbar can also be used to paste the current contents of the clipboard:

Paste the current clipboard contents
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Delete
Delete the selected images from the fade. The delete button on the toolbar can also be used to delete the current selection:

Deletes the current selection

Select all
Select all images within the fade.

Clear
Clear the selection of images within the fade.
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Toolbar
The toolbar at the top of each slideshow window gives the following functionality:

Save the slideshow

Runs the slideshow from the beginning

Display the fade details used to move to the next picture

Display the fade details used to move to the previous picture

Displays the details for the selected picture

Copies the selection to the clipboard

Cuts the selection the clipboard

Paste the current clipboard contents

Deletes the current selection

Page 27



Choices
The icon bar menu allows access to a Choices window which allows the following choices to be set:

Use global choices by default
It is possible to configure each slideshow to override most of the options that this window provides - see the section Slideshow
choices for details. Switching this on means that by default any newly created slideshows will use this, the global set of choices.
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Window layout
The main slideshow window supports horizontal and vertical layout. This controls which is used by default:

Vertical layout Horizontal layout
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Slide colour
The default background colour for any slides within a slideshow. This can be set on a per slide basis if desired.

Default fades
This allows the next and previous fades that are used when a new picture is added to be set.

Speed
The overall speed of the sequence specified here applies to the frequency at which a transition takes place.

For example, a slow setting in the Fade details window and a fast setting here means that a transition will use very small steps
but each step will happen as fast as possible. This gives the smoothest transitions.

A fast setting in the Fade details window and a slow setting here means that a transition will use large steps but the delay between
them will be larger. This will give a jerky transition.

This level of control is provided to enable the user to get the best setting for their computer. Very fast computers can use the
smoothest settings but slower computer might need to settle for less smooth transitions.
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Highlight
These options control the effect when a slideshow is paused and Select is used to highlight certain areas.

Size
The size of the ‘pen’ to use to highlight.
    
Colour
The colour of the ‘pen’ used to highlight.

Save path
The path where any saved highlighted images will be placed if the S key is pressed to save highlights when running a slideshow.

Images

Load thumbnails
When set thumbnail images will be displayed within the fade window. However, on a slow machine or if a fade contains a lot of
images this can be slow when displaying for the first time. Turning this option off causes no thumbnail images to be displayed.

Cache thumbnails
Turn this on to save the thumbnails that are used to display the slideshow. This will make loading the slideshow quicker because
the thumbnails will not have to be generated.

Use ChangeFSI
If this is set Fade will always use ChangeFSI to render images even if ImageFileRender is available.

Copy pictures
When set this will cause Fade to copy the pictures that make up a slideshow into the save directory.
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Cache slides
Switch on to cache the slide images that are generated when the slideshow is run. Useful on slower machines using ChangeFSI
where it can take a few seconds to generate the image to be displayed. Editing the slideshow or changing Choices will cause
the cache to be cleared.

Keep in mind that a slideshow in a high resolution high colour screen mode with lots of slides will use a significant amount of
disc space if this option is turned on.

Miscellaneous

Run slideshow continuously
When set this will cause a slideshow to loop continuously until the Menu button is clicked.

Mode

Set Mode
When set this will cause the screen mode to be changed to that specified when running the slideshow.

Old style
Allows an old style mode number to be specified

Mode number
An old style mode number.
    
Colours
The number of colours to use when running the slideshow if the Set Mode option is set.
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Resolution
The resolution of the  screen to use when running the slideshow if the Set Mode option is set. This will display the same set of
available resolutions as the Display Manager on the iconbar. Older versions of RISC OS are limited to a fixed set of resolutions.

Choosing a resolution and colours resulting in more memory being required than is available to the video drivers will result in a
lower colour mode being selected.

HTML choices...
This will open a further window that allows the way in which slideshows exported to HTML will appear.
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HTML Choices
Allows the way in which a slideshow exported to HTML will appear:

Slide size

Width
The width of the slide image in pixels.

Height
The height of the slide image in pixels.
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Navigation

Use frames
Switch on to generate a frames based display with separate title, navigation and slide display sections.

Next / previous buttons
Switch on to include Next and Previous buttons under the slide to navigate between slides.

Auto progress

JavaScript
Switch on to use JavaScript to automatically progress to the next slide after the configured delay. If this is switched off and a
delay is specified then an alternative technique is used to progress to the next slide that should work on non JavaScript enabled
browsers.

Delay
The delay in seconds until the next slide is displayed. A setting of 0 means that the next slide will not be automatically displayed.

Colours

Text
The colour of any text that will be displayed in the HTML slideshow.

Back
The background colour of the HTML slideshow.
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Slideshow choices
Choices can be set individually for slideshows by choosing the Choices item from the Slideshow menu:

This will display a Choices window similar to the application wide choices:

The only addition is the Reset to global choices button which will reset the choices for the slideshow to the current application
choices settings.

Also, the mode selection options are only available from with the main Choices window.
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The main menu
The main menu is displayed by clicking Menu over a window:

The following options are available:

File
Moving the pointer over this item shows the File menu:
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Info
Displays information about the file including when it was last modified, the name and size:

Save
Displays a standard save dialog box. The fade can be saved by dragging the icon to a filer window or entering a name and clicking
OK:
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Save HTML
Displays a standard save dialog box with an extra option button that allows a preview of the slideshow to be saved or an HTML
version of the full slideshow.

New view...
Choosing this item displays another window containing the same fade. This can be useful when copying or moving pictures
from one section of a large sequence to another.
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Edit
Moving the pointer over this item shows the Edit menu.:

This is covered in detail in the Cut & paste and Operating on multiple pictures sections.

Slideshow
Moving the pointer over this item shows the Slideshow menu:

Run
Choosing this item will start the slideshow from the beginning. The section Running the slideshow details how to control the
slideshow.
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Continue
Starts the slideshow from the place it was last stopped.

Choices
This displays the Choices window for the slideshow.

Clear cache
Clears the thumbnail and image cache associated with the slideshow.

Help
This will display the help displayed with the application.
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The iconbar menu
Clicking Menu over the Fade icon on the iconbar will display this menu. The following items are available:

Info
Moving the mouse pointer over this item displays the About this program window which displays version information about Fade.

Choices...
Displays the Choices window which allows preferences for the application to be set. This is covered in detail elsewhere.

Quit
Choosing this item will cause Fade to exit.

Help
This will display the help displayed with the application.
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